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Regulatory model: M80 

Trademarks 

Microsoft is a U.S. registered trademark of Microsoft 
Corporation. 
Windows and MS-DOS are trademarks of Microsoft Corporation. 
IBM, IBM PC are registered trademarks of International Business 
Machines Corp. 
ENERGY STAR® is a U.S. registered mark. 
Other brands and product names herein are trademarks or 
registered trademarks of their respective holders. 

Copyright 

All rights reserved. No part of this publication may be 
reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language or computer language, 
in any form or by any means, electronic, mechanical, magnetic, 
optical, chemical, manual, or otherwise, without the prior 
written permission of iVina Inc. 
 
Material scanned by this product may be protected by 
governmental laws and other regulations, such as copyright 
laws, the customer is solely responsible for complying with all 
such laws and regulations. 

 

Warranty 

The information contained in this document is subject to 
change without notice. 
 
iVina makes no warranty of any kind with regard to this 
material, including, but not limited to, the implied warranties 
of fitness for a particular purpose. 
 
iVina shall not be liable for errors contained herein or for 
incidental or consequential damages in connection with the 
furnishing, performance, or use of this material.  



M80 Manual V.3 Aug 2010 iii 

 
 
FCC Radio Frequency Interference Statement  

This product has been tested and found to comply with the 
limits for a class B digital device, pursuant to Part 15 of the 
FCC rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that may 
cause undesired operation.   The FCC Class B limits are 
designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment 
generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or 
television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following 
measures: 

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and 

receiver. 

 Connect the equipment into an outlet on a circuit 

different from that to which the receiver is connected. 

 Consult your point of purchase or service representative 

for additional suggestions. 

 

 

CE Warning 

This product satisfies the Class B limits of EN55022, EN55024 

and safety requirements of EN 60950. 
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Disposal of Waste Equipment  

 

This symbol on the product or on its packaging indicates that 
the product can not be disposed of with your other household 
waste.  Instead it should be sent to appropriate facilities for 
recovery and recycling in an effort to protect human health and 
the environment.  Fore more information about where you can 
drop off your waste equipment for recycling, please contact 
your local city office, your household waste disposal service or 
the shop where you purchased the product.   
 
 
 

 

As an ENERGY STAR® Partner, iVina Inc. has 
determined that this product meets the ENERGY 
STAR guidelines for energy efficiency. 

 
 
 
*This machine is certified as Class 1 laser product. This means 
that this machine does not produce hazardous laser radiation. 
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System Requirements 

 
 Microsoft Windows XP/Vista/7 
 1.2 GHz CPU or greater * 
 512 MB RAM for Windows XP (2+ GB RAM 

recommended) 
 1 GB RAM for Windows Vista and 7 (2+ GB RAM 

recommended) 
 500 MB available on the Hard Drive for complete 

software installation 
 USB 2.0 Port 
 CD-Rom drive 
 Display supporting full color (32 bit) at 800 x 600 

 
* File conversion speeds and OCR performance are linked to 
CPU speed.  The faster the processor, the better the results. 

 



 vi 

Table of Contents 

 

1. Introduction ................................................................ 1-1 

2. Scanner Installation ................................................... 2-1 

2.1 Installing the Scanner Driver and Cables ................ 2-1 
2.1.1 Installing the Scanner Driver ............. 2-2 
2.1.2 Connecting to Computer ................... 2-3 

3. Completing Your First Scan ...................................... 3-1 

3.1 Input Document Specifications ............................ 3-1 
3.2 Using the BulletScan Manager ............................. 3-1 

3.2.1 Loading Paper to the Paper Feed Slot .. 3-2 
3.2.2 Loading A Card to the Paper Feed Slot 3-3 

3.3 Verifying Your Scanner Installation ....................... 3-4 
3.4 A Glance of the Scanner Properties Dialog Box ........ 3-8 

4. Using the Scanner Properties Dialog Box ................ 4-1 

4.1 Buttons on the Scanner Properties Dialog Box ......... 4-2 
4.2 The Image Tab ............................................... 4-4 

4.2.1 The Image Selection Box................... 4-5 
4.2.2 Other Image Options ........................ 4-8 
4.2.3 Scanning color images ..................... 4-18 
4.2.4 Scanning grayscale images .............. 4-19 
4.2.5 Scanning B&W images ..................... 4-19 
4.2.6 Editing Profiles ................................ 4-20 

4.3 The Compression Tab ...................................... 4-23 
4.4 The Color Dropout Tab .................................... 4-25 

4.4.1 Color Dropout Selection ................... 4-25 
4.4.2 Other Color Dropout Options ............ 4-27 

4.5 The Paper Tab ............................................... 4-29 
4.5.1 Cropping ........................................ 4-30 
4.5.2 Other Paper Selection ...................... 4-32 
4.5.3 Multimode cropping ......................... 4-34 

4.6 The Preview Tab ............................................ 4-37 
4.7 The Options Tab ............................................ 4-38 
4.8 The Setting Tab ............................................. 4-45 



M80 Manual V.3 Aug 2010 vii 

4.9 The Information Tab ....................................... 4-48 

5. Using the Buttons ....................................................... 5-1 

5.1 The BulletScan Manager .................................... 5-1 
5.2 Scanning From One Touch of the Buttons ............... 5-1 

6. Care and Maintenance ................................................ 6-1 

6.1 Cleaning the Scanner Glass ................................ 6-1 

7. Troubleshooting ......................................................... 7-1 

7.1 Clearing a Paper Jam ....................................... 7-1 
7.2 Frequently Asked Questions ............................... 7-1 
7.3 Technical Service ............................................ 7-2 

8. Specifications ............................................................. 8-1 

Index ........................................................................................ a 

 





 

M80 Manual V.3 Aug 2010 1-1 

1. Introduction 
 
 
Congratulations on your purchase of the BulletScan M80 
mobile document scanner.  With this scanner, you can scan 
documents directly to PDF and other digital file types, 
increasing your productivity.  

Before you install and operate the new scanner, please take 
a few minutes to read through this manual.  It provides 
proper instructions for you to unpack, install, operate and 
maintain the scanner. 

The following figure indicates the package contents.  Please 
check all the items against your checklist.  If you do not 
receive all the items, please contact your authorized local 
dealer immediately. 
 

 

 

 

 

1. Scanner 
2. Scanner travel case 
3. Installation CD 
4. USB cable 

Note:  
Please unpack the packing carefully, and check the contents 
against the checklist.  If any items are missing or damaged, 
please contact your dealer immediately.  

3 
4 

1 
2 
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2.   Scanner Installation 
 

 
 

Precautions 

 
 Keep the scanner out of direct sunlight.  Direct exposure 

to the sun or excessive heat may cause damage to the 
unit. 

 Do not install the scanner in a humid or dusty place. 

 Place the scanner securely on an even, flat surface.  
Tilted or uneven surfaces may cause mechanical or 
paper-feeding problems. 

 Retain the scanner box and packing materials for 
shipping purposes. 

2.1 Installing the Scanner Driver and Cables 

Note:  
For best results, install the software from the CD before 
connecting the M80 to your computer. 
If you have already connected the M80, but not installed the 
software, simply disconnect it and start installing from the CD. 
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2.1.1 Installing the Scanner Driver 

 

1. Place the supplied CD-ROM onto your CD-ROM drive. 

2. The software installation screen appears.  If not, run 
“setup.exe”. 

 

 

 

 

 

 

 

 

 

 

Contents on the installation disc: 

 Easy Install:  Click to install all bundled software 
including scanner driver, BulletScan Manager, 
NewSoft Presto! PageManager, and NewSoft Presto! 
Bizcard Reader. 

 Advanced Install:  Choose for a selective 
installation. 

 Documentation:  Click to view quick install guide, 
scanner manual, BulletScan Manager manual and 
other software manual. 

 Go Online: Click to go online to the Bulletscan.com    
website. 
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2.1.2 Connecting to Computer 

 

The scanner will get its power from the computer through the 
USB cable. Use the USB cable that came with the scanner to 
connect the scanner to the computer.  
 

1. Connect the small end of the USB cable to the USB port of 
your scanner.  Connect the rectangle end to the USB port of 
your computer. 

 

2. The computer should detect a new USB device and prompt 
a “New Hardware Found” message. 

3. In Windows XP, click the Next button to continue. When 
the XP certification screen appears, click Continue 
Anyway to complete the installation. 

In Windows Vista, click the Recommended option, and 
then click Continue button to complete the installation. 

4. When the Finish dialog is prompted, click the Finish 
button.  

Click “View Manual” to view or print the detailed user manual 
for the scanner and bundled applications respectively. 
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3. Completing Your First 
Scan 

 

3.1 Input Document Specifications 

Before using the scanner, please make sure that your paper 
meets the following specifications: 

 

 Document(s) can range in size from 2.9 by 2.1 inches to 

8.5 by 14 inches (Legal). 

 Document(s) can range in weight from 13.3 to 32 lbs (50 

~ 120 g/m2) 

 Plastic ID cards up to 1.25 mm thick  

 Document(s) should be square or rectangular and in good 

condition (not fragile or worn). 

 Document(s) should be free of curl, wrinkle, tears, wet 

ink, or punch holes. 

 Document(s) should be free of staples, paper clips, paper 

sticky notes. 
 

 

3.2 Using the BulletScan Manager 

To use the BulletScan Manager with the M80, simply insert a document and 

press the “One Side” or “Two Sides” button on the scanner.  This will do a one-

sided or two-sided scan using Button 1 on the BulletScan Manager software.  

See the BulletScan Manager manual for more details on how to configure this 

software. 
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3.2.1 Loading Paper to the Paper Feed Slot 

 

 

The scanner is a duplex scanner, which means it can scan 
both sides of the page at the same time. However, the 
scanner can only scan one page at a time. 
 
1. When scanning a single sided of the document, insert the 

document facing up with the top of the page pointing to 
the paper feed slot.  When scanning both sides of the 
document, the top facing side of the document will be the 
first image processed. 

2. Align the original to the left side of the paper feed slot. 
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3.2.2 Loading A Card to the Paper Feed Slot 

 

 

1. Place the card face up with the long side parallel to the 

paper feed slot and make sure the top of the card points 

to the paper feed slot. 

 

 
2. Align the original to the left side of the paper feed slot. 
 
 

 

Note: 
This scanner is able to scan plastic ID cards up to 1.25 mm 
(0.05 inch) thick.  
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3.3 Verifying Your Scanner Installation   

Once you've loaded your scanner, you should be able to begin 
scanning simply by clicking on 
the BulletScan icon in the system 
tray and clicking on the 
destination number.   
 

 
 
 
 

 
 
 

 
By default, inserting a document and 
pressing the scan button will give 
you a PDF in NewSoft Presto! PageManager.  For more 
information on using the BulletScan Manager, please refer to 
the BulletScan Manager User Manual PDF. 
 
If this doesn't work, you can verify if your scanner installation 
is correct, iVina provides you a simple image capture program 
called iVina Capture Tool.  With this tool, you can perform 
simple scans to many image formats and immediately view the 
results.  In addition, you can do use it to do speed tests and 
other operations 
 
If your scanner is not responding after installation, the 
following procedure shows you how to verify your scanner 
installation.  If the scanner is not working, please check both 
ends of the power and USB cables, verify the shipping lock is 
disengaged, and restart the scanner and computer.  
 
Before you begin, be sure the scanner is on. 
 
1. Select Start>Programs>BulletScan>iVina Capture Tool.  If 

there is nothing in the start menu labeled ―BulletScan‖ you 
must install the software from the CD. 

BulletScan Manager icon 
on Windows XP 

BulletScan Manager icon 
on Windows Vista/7 
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2. The Select Scanner Model dialog box will be displayed.  

 
3. Select TWAIN (your driver type) and the F200 (scanner 

model) and click OK.  The following iVina Capture Tool 
dialog box will be displayed. 

 

 
 
 

 

4. Choose your desired file format from the File Format drop 
down list box. (Default is BMP, other choice includes TIFF, 
GIF, and JPEG.) 

5. Type your desired folder name and file name in the File 
Path box. (Default is C:\My Scan\Image.) 

Note: If you do not wish to save the scanned image, click 
the Save button (Floppy Disk icon) as this option is enabled 
by default. Also, if you disable saving, the thumbnail view 
will be disabled and you’ll only be able to view the last 
captured image.  

6. Click the Setup button ( ) or choose Setup from the 
File menu to prompt the Scanner Properties dialog box. 

 
 
 
 
 

Setup      

Actual  

Size 

Fit 

Page 

Scan 
File Format 

Save       File Path 
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7. From the Image Selection Box, choose your desired image 

type for your scanned image.  (Default is Front B&W)  If 
you have a duplex scanner, choose Front and Rear to scan 
both sides of your document.  

8. Click OK to quit the Scanner Properties dialog box.  (To 
learn more details about the Scanner Properties dialog box, 
please see the subsequent chapter, Using the Scanner 
Properties Dialog Box.) 

9. Place your document face down on the document glass or 
face up in the auto document feeder. 

10. In the Scan Validation dialog box, click the Scan button 

( ) or choose Scan from the File menu. 

11. The document will be scanned and displayed in the Scan 
Validation screen.  After the scanned images have been 
displayed, your scanner installation verification is 
completed.  

Image 
Selection 

Box 
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12. You can view the scanned image in Fit Page ( ) or 

Actual Size (100%) button ( ) from the Viewing 
toolbars at the right side. 

13. Click the Close box or Quit from the File menu to exit the 
Scan Validation Tool. 

Fit Page View Thumbnail View 
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3.4 A Glance of the Scanner Properties Dialog Box 

 

 
 

1. Tab Options Choice:  Image, Compression, Color Dropout, 
Paper, Options, Settings, Information. 

2. Image 
Selection Box    

Choose your image type and the side of 
document you wish to scan.  Options vary 
based on type of scanner.  

3. Brightness: Adjust the brightness level from –100 to +100.   

4. Contrast Adjust the contrast level from –100 to +100. 

5. Resolution Determine the quality of the scanned image.  
The industry standard is 200 dpi. 

6. Invert Reverse the color of your scanned image. 

7. Scan Source  Choice: Auto Document Feeder, Flatbed, 
Flatbed (Book), Automatic (varies due to 
different scanner model)  

8. Defaults Reset all values on the tabs to the factory 
default settings. 

 
 

 

 
    

3 

4 

5 

6 

 

7 

1 

 

2 

8 
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4. Using the Scanner 
Properties Dialog Box  

 
 
 
 
The Scanner Properties dialog box allows you to configure the 
scanner’s settings. It consists of several tabbed windows each 
of which will be described in this chapter. 
 

 
 

The Scanner Properties dialog box 
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4.1 Buttons on the Scanner Properties Dialog Box  

 

The buttons on the Scanner Properties dialog box 

 
Buttons Description 

Defaults Click the Defaults button, the factory default 
settings will be shown on each tab.   

Scan After all the scan settings are satisfactory, click 
the Scan button to start scanning your 
document. 

Close Click the Close button to leave the Scanner 
Properties dialog box. 
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The following table shows the default settings： 

 

Tab name Default settings 

Image Image：Front B&W 

Binarization：Dynamic Threshold 

Resolution：200 dpi 

Invert：Blank on White 

Scan Source：Auto Document Feeder 

Threshold：None 

Brightness：None 

Contrast：None 

Compression None 

Color Dropout None 

Paper Cropping：Automatic 

Deskew：Yes 

Orientation：Portrait 

OverScan：0.00  

Multifeed Detection：None 

Unit：Inch 

Options Rotation Degrees：None 

Blank Page Removal：None 

Edge Fill：White，0 mm 

Image Control Option：None 

Setting Enable Energy Saver：Enable, 15 

minutes after last scan action 
Show Scanning Progress：Yes 

Show Warning Message：Yes 

Save Settings after Closing：Yes 
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4.2 The Image Tab  

The Image tab allows you to choose the front side and (or) the 
rear side of your document, the type of image, and to set 
several basic scan settings.  Note that except for the resolution, 
you can set individual scan settings for the front side and the 
rear side.  For example, all settings in the Image tab, 
Compression tab, Color Dropout tab can be set individually for 
the front and the rear side.  However, the settings in the Paper 
tab, the Option tab, and the Setting tab have to be set the 
same for the front and rear side.   

 

 
 

The Image tab dialog box 
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4.2.1 The Image Selection Box 

 

The Image Selection box includes 
the color depth and document side 
option.  If you wish to scan both the 
front side and the rear side of your 
color document, you can check both 
Front Color and Rear Color at the 
same time.   

 
Example 1：Scanning a two-sided color document, both 
sides in color 

 
 

Side/Image 
Selection 

 
Front 

 
Rear 

1  
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Example 2：Scanning a two-sided color document, one in 
B&W(Drop Blue Color：Threshold：10, Background：79), 
the other in color 

 

 

Side/Image 
Selection 

 

Front 

 

Rear 

 

Image Type Description 

Color Choose Color if you wish to scan a color 
image for your original in color.  

Gray Choose Gray image if your original contains 
actual shades of gray. 

B&W Choose B&W if your original contains only 
text, pencil or ink sketch. 

  
 

B&W Gray Color 
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Front/Rear Auto Color Detection:  

Click to automatically detect and scan the front or the rear 

page of your color document in color image mode.  If your 

document is in color, the scanner will automatically scan the 

document into a color image.  If your document is non-color, 

you can choose the output to be either B&W or Gray from the 

Non-Color Selection option.  This option is typically used when 

you have a mixture of color and non-color document. 

Note:  If you enable Auto Color Detection for either side, it will 
be enabled for both sides if you are scanning in duplex. 
 

 

Sensitivity of Auto Color Detection 
 
If your documents contain primarily B&W text and small 
amount of light or pale colors and you do not wish them to be 
recognized as color image to save the file size, you can reduce 
the sensitivity value by moving the bar to the left to let these 
images to be detected as B&W. The value ranges from 1 to 30.  
The default is 20. 



 4-8 

4.2.2 Other Image Options 

Binarization This is the process of converting a 
grayscale or color image to a bi-tonal or 
Black and White image. There are several 
different methods of performing this 
conversion.  Options:  Dynamic 
Threshold, Fixed Processing, Halftone 
1~5, Error Diffusion. 

Dynamic Threshold:  Selecting 
Dynamic Threshold allows the scanner 
to dynamically evaluate each document 
to determine the optimal threshold value 
to produce the highest quality image.  
This is used for scanning mixed 
documents containing faint text, shaded 
backgrounds, or color backgrounds with a 
single setting.  If Dynamic Threshold is 
selected, Threshold, Brightness, and 
Contrast are not available. 
 
Sensitivity of Dynamic Threshold 
 
Occasionally your scanned image may 
contain small dots or speckles. To remove 
these spots, increase the sensitivity value 
by moving the bar to the right. The value 
ranges from 1 to 30.  The default is 20. 
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 Fixed Processing:  Used for black-and-
white and other high contrast documents.  A 
single level is set to determine the black-
and-white transition. The threshold is 
programmable over the entire density 
range.  Fixed Processing sets Contrast to 
0.  If Fixed Processing is selected, 
Contrast is not available. 

 

 Halftone:  In addition to the black and 
white display, Halftone can present a 
somehow gray shade of image by using 
different size of dots.  Halftone image looks 
like the picture we have seen in the 
newspaper.  Options include Halftone 1, 
Halftone 2, Halftone 3, Halftone 4, 
Halftone 5.  
 
Error Diffusion:  Error Diffusion is a type of 
Halftone.  Error Diffusion is a compromise 
between giving good image texture and 
makes text in images more readable than 
Halftone. 
 

 
Halftone Image 
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Error Diffusion Image 
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Threshold Used to convert a grayscale image to a  

Black & White image. The value ranges from 
0 to 255. A low threshold value produces a 
lighter image, and can be used to subdue 
backgrounds and subtle, unneeded 
information. A high threshold value produces 
a darker image, and can be used to help pick 
up faint images.  
Adjust the threshold setting by dragging the 
Threshold sliding bar to the left or right to 
achieve the desired threshold setting. 
 

 
 
200 dpi, 
Threshold:80, 
Brightness: 0 

 
 
200 dpi,  
Threshold:170, 
Brightness: 0 
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Gray  
Document Type:  Normal, Photo, Document   
Three options for document type are provided when you choose 
Gray as the color depth for your scanned document.  Choice:  
Normal, Photo, Document.  

 Document: Choose Document if your original contains 
pure text or a mixture of text and graphic since it is an 
optimal setting for regular business document.  When 
using Document, only Threshold can be adjusted.   

 Photo: Choose Photo if your original is a photo or similar 
to reproduce your photo in vivid grayscale image.  When 
using Photo, Threshold and Contrast are locked. 

 Normal: When using Normal, Threshold, Brightness, and 
Contrast can be adjusted.  

 
Threshold:  The value ranges from 0 to 255.  The default is 
230.  A low threshold value produces a lighter image, and can 
be used to subdue backgrounds and subtle, unneeded 
information. A high threshold value produces a darker image, 
and can be used to help pick up faint images. Adjust the 
threshold setting by dragging the Threshold sliding bar to the 
left or right to achieve the desired threshold setting. 
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Normal 

 
Photo 

 
Document 

(Threshold: 230) 

 

 
Normal 

 
Photo 

 
Document 

(Threshold: 230) 
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Brightness Adjusts the lightness or darkness of an 
image.  The higher the value, the brighter 
the image.  Drag the slider to the right or 
left to increase or decrease the brightness.  
The range is from –100 to +100. 

Contrast Adjusts the range between the darkest and 
the lightest shades in the image.  The 
higher the contrast, the bigger the 
different grayscale. Drag the slider to the 
right or left to increase or decrease the 
contrast.  The range is from –100 to +100. 

 

  
 

Brightness: -50 Brightness: 0 
(Normal) 

Brightness: +50 

   
Contrast: -50 Contrast: 0 

(Normal) 
Contrast: +50 
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Resolution Resolution is the value that controls how 

much information is captured when the scan 

is performed.  A higher resolution will 

capture more information and increase the 

file size, trading off performance for quality.  

Most business documents are best saved in 

200 or 300 DPI (Dots Per Inch) depending on 

the size and quality of the text.  For 

reference, an letter size color image scanned 

at 300 dpi at in color consumes about 25 MB 

of disk space when uncompressed. A higher 

resolution (over 400 dpi) is only 

recommended when you need to scan a very 

small area.  

Choose a resolution value from the drop 
down list. The default value is 200 dpi. 
Available resolutions are 75, 100, 150, 
200,300, 400 and 600. Or you may manually 
set the resolution by clicking the button 
labeled […] next to the drop down list and 
enter your desired value, pressing the Add 
button to include it in the drop down list. 

 
Resolution: 75 dpi  

Resolution: 150 dpi 
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Invert Reverses the brightness and the colors in the 

image.  The default setting is Black on a White 
background.  Reverse mode is White on a Black 
background. For color images, each pixel will be 
changed into its complementary color if it is 
Inverted. 

 
Black on White 

 

 

White on Black 
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Scan 
Source 

Choice: 
 Auto Document Feeder:  Used to scan 

multiple pages. 
 Merge Two Sides into One Image:  

When scanning, you can scan an 11‖x17‖ 
size document using this innovative method.  
To do this, fold your 11‖x17‖ size document 
in half to 8.5‖x11‖, and then load the paper 
in the front tray.  Choose Merge Two Sides 
from the Scan Source option and then the 
scanner is able to scan both sides of your 
document and merge the two sides into a 
single output image.  

 
When you select Merge Two Sides into One 
Image, the Cropping or Multi-feed function 
will be disabled. 
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Color 
Matching 

 

The purpose of Color Matching is getting the 
accurate color. This option uses the default 
parameters (ICC profile) to adjust the colors 
of the image. 

            
                        Normal 
 

           
                 After Color Matching 

 

4.2.3 Scanning color images 

The following options are available for scanning color images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 
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4.2.4 Scanning grayscale images  

The following options are available for scanning gray images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

  

4.2.5 Scanning B&W images  

The following options are available for scanning B&W images.  

 Binarization (Dynamic Threshold) 
 Resolution 
 Invert 

 
Or 

 Binarization (Fix Processing) 
 Threshold 
 Brightness 
 Resolution 
 Invert 
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4.2.6 Editing Profiles 

 
The Scanner Properties dialog box allows you to change and 
save your frequently used scan settings into a profile.  You can 
edit these profiles by renaming or deleting them.  
 
To add a new profile, 
 
1. Customize your settings.  (For example, change your 

resolution, image type, cropping method, scan size, or 
other scan settings.)  

2. Click the Image tab and then choose ―Profiles‖ to prompt 
the ―Edit Your Profile‖ dialog box.  

 
 
3. Click ―Add‖ to enter the name of the profile and then 

choose ―Save‖. 

 
 
4. The new profile will be saved and shown in the ―Profiles‖ 

dropdown list box.  
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To load a profile,  
 
 
1. From the Image tab dialog box, choose your favorable 

profile from the ―Profiles‖ dropdown list box. 

 

2. Your favorable profile will be immediately loaded and 
displayed on Scanner Properties dialog box. 

 
 
To delete a profile, 
 
1. From the Image tab dialog box, click ―Profiles‖ to prompt 

the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to delete from the dropdown 

list box. 
3. Click ―Delete‖.  A Confirm message ―Are you sure you want 

to delete this profile?‖ is prompted. 
4. Choose ―Yes‖ to delete or ―Cancel‖ to quit. 
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To rename a profile, 
 
 
1. From the Image tab dialog box, click ―Profiles‖ to prompt 

the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to rename from the dropdown 

list box and then click the Rename button. 
 
3. Enter new name for the profile. 

 
 
4. Choose ―Save‖ to save the new profile or ―Cancel‖ to quit. 
 

Note: 
The preset default profiles includes Simplex-B&W, 200 dpi, 
Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-B&W, 
200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi.   
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4.3 The Compression Tab 

The Compression tab allows you to compress your scanned 

image and choose the level of compression.  Bi-tonal (Black 

and White) images are normally compressed using CCITT Group 

4 (G4) standard.  Color and grayscale images are often 

compressed using JPEG compression.  Move the JPEG Quality 

slider to the right or left to increase or decrease the level of 

compression.  Note the greater the compression level, the lower 

image quality.  Default is 50%. 

 

Note that when scanning from certain applications, not all 

compression modes are supported.  If the application does not 

support the type of compression format, typically you will see 

an error or a black image.  

 
JPEG (Joint Photographic Editor Group).  This group developed 
and lent their name to a file compression standard for color and 
grayscale images that is widely used by scanners, and software 
applications.  On Microsoft Windows-based systems, a file with 
the extension .jpg has normally been compressed using this 
standard. 

 
For scanning color or gray images, the following compressions 
are available: 

 None 
 JPEG 

 
For scanning B&W images, the following compressions are 
available: 

 None  
 G4 
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The Compression tab dialog box 
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4.4 The Color Dropout Tab   

4.4.1 Color Dropout Selection 

Color Dropout is a special type of image processing designed to 
improve OCR results by removing specific types of background 
color content.  Typically this is used in conjunction with 
specially designed forms that have colored boxes or checkboxes 
that people fill in.  Using dropout allows you to remove these 
specially colored boxes from the image and provides you with 
better OCR results.  It can also be used to remove a specific 
background color if it is causing a lot of noisy speckling.  

From the dropdown menu, you can select any of the standard 
RGB color channels to be removed, or Custom to allow you to 
specify your desired color to be removed by entering its RGB 
(Red, Green, and Blue) value respectively.  
 
Tolerance: Specify the allowable color range to be removed for 
the color you selected. Specified range: 1 ~ 100  
The large the numeric value, the wider the color dropout range 
is.  
 

Note that this function is only for outputting black & white or 

gray images.   
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The Color Dropout dialog box 
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4.4.2 Other Color Dropout Options 

 
Advanced Processing provides two options that can adjust 
your scanned image in the best optimal result. 
 
Filter 
Threshold 

This value is used to determine the color 
which will be dropped out.  A lower value will 
drop more of the selected color out, while a 
higher value will leave more of the selected 
color in. 

Background 
Level 

The pixel which is higher than the 
background value will be adjusted to the 
lightest point.  Adjust the value for both the 
Filter Threshold and Background Level to 
produce the best optimal result. 
 

Example, slightly adjusting the background value makes 
your text more clear.  
 

 
Original 
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Remove Blue, Threshold: 20, Background: 
255 

 
Remove Blue, Threshold: 20,  
Background Level: 210 
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4.5 The Paper Tab  

The Paper tab allows you to define values relating to image 
output (i.e., Auto Crop or not, Scan Area, OverScan).  
 

 

The Paper tab dialog box 
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4.5.1 Cropping  

Cropping allows you to capture a portion of the document 

being scanned.  Choice:  Automatic, Fixed to Transport, 

EOP (End of Page) Detection. 

 

Options Description 

Automatic Automatic adjusts the cropping window 
according to different document sizes. Use 
this option for batches of mixed-sized 
documents. 

Fixed to 
Transport 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-sized documents.  If you select this 
option, you can use the arrow keys to 
define the x and y offset values, width and 
length to redefine your scanned area.  The 
Display window will show image placement 
as you change the values. 

EOP (End of 
Page) 
Detection 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-width but different length 
documents.  If you select this option, you 
can use the arrow keys to define the x and 
y offset values, width and length to 
redefine your scanned area.  The Display 
window will show image placement as you 
change the values. 
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The following options are only available when Fixed to 
Transport is selected.  

 
 X-Offset — the distance from the left end of the 

scanner to the left edge of the scanning area.  

 Y-Offset — the position from the top end of the 

document to the top end of the scanning area.  

 Width — the width of the scanning area.  

 Length — the length of the scanning area.  

 Center: automatically calculates the x-offset for center-fed 

feeding based upon document size selected. 

 — move the scan area by click the arrow key on the 

cross sign while retain the scan size.  View the result from 

the Display window.   
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4.5.2 Other Paper Selection 

Deskew 

Use this option to automatically deskew (straighten) a 

document.   

  
 
 
Scan Area  

Choose your desired paper size with the drop-down list box.  Or 
you may select a custom paper size by clicking the Scan Area 
box and then click Add to include in the choice. 

Choice:  None, US Letter- 8.5‖x 11‖, US Legal – 8.5‖ x 14‖, 

ISO A4 – 21 x 29.7 cm, ISO A5 – 14.8 x 21 cm, ISO A6 – 10.5 

x 14.8cm, ISO A7 – 7.4 x 10/5 cm, ISO B5 – 17.6 x 25 cm, ISO 

B6 – 12.5 x 17.6 cm, ISO B7 – 8.8 x 12.5 cm, JIS B5 – 18.2 x 

25.7 cm, JIS B6 – 12.8 x 18.2 cm, JIS B7 – 9.1 x 12.8 cm, 

Scanner Maximum, Long Page. 

 
Long Page:   
When you need to scan documents whose length exceeds 
scanner maximum, please choose Long Page.  Note if Long 
Page is selected, the Multi-Feed Detection will not be available. 
Options: Unknown Length, Enter Length   (Note: This option 
varies due to type of scanner.)   
 

Note: If the skew angle is 
too great, some of the 
image may be cut off. 
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Choose ―Unknown Length‖ if you have a batch of long page 
document with unknown length. Choose ―Enter Length‖ to enter 
the length and width of your documents or your desired scan 
size on documents.  This is useful when you have a batch of 
documents with the same scan size or a batch of same-sized 
documents. 

OverScan 
Overscan allows you to add a specific margin at top and bottom 
or right and left (Options vary based on the type of scanner) of 
the edge of the image.  This is used to reduce possible corner 
clipping on the skewed images and often applied to a batch of 
skewed document to be scanned in the auto document feeder.  
Select a value between 0 and +5 mm.   Note the overscan 
result will not be shown in the Display window and that the 
availability of the function varies based on type of scanner.  
 
 
Pre-Feed 
Choice:  Enable, Disable.  If enable is selected, you can set the 
amount of time the scanner starts pre-feeding your paper after 
your documents has been loaded into the feeder. The default is 
disable. 
 
Transport Timeout 
Set the amount of time the scanner will wait and then 
automatically continue to scan after the first scan job is 
completed. If you have many separate documents that need to 
be scanned at the same scan settings, this feature is especially 
useful. The default is 0.  The value ranges from 0 to 30 
seconds. 
 
 

Note:  
1 Within the specified timeout period, if you load your 

document to the feeder, the scanner resumes scanning 
automatically. 

 



 4-34 

4.5.3 Multimode cropping 

This feature provides flexibility if you are performing a scan 
that outputs in a more than one mode (B&W, Gray, or Color); 
you can assign different crop areas on your documents for each 
color mode.  For example, there are applications which require 
you to store the entire form in B&W and a part of the document 
in color to save storage space.  This is useful for documents 
where a photograph, or signature appears in a consistent area 
on the document such as resumes, and so on.   

 
The following directions describes how to scan the entire 
document in B&W and keep a small portion of the document 
(picture) in color.   

 
1. On the Paper tab, choose ―Relative to Document‖ or ―Fixed 

to Transport‖ from the Cropping option. 

2. Choose your scan size from the Scan Area option.  The 
selected scan size will be displayed in a red rectangular 
box.  This is also the scan size of your entire document. (If 
you have not chosen a scan area and leave the selection 
as None, then the default area will be the scanner’s 
maximum.)  

 
 
3. Click the Preview tab to display the Preview window.  A 

black rectangular box appears to indicate the max. scan 
size your have just selected. 

1 

2 Scan Area 
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4. Click the Preview button to view the entire image in low 

resolution to correctly crop your relative scan area.  

 

5. Select the image type from the Image Selection box.  The 
selected image will appear in highlighted color. (For 
example, Front Color) 

6. Place your cursor on the Preview window and click your left 
mouse button.  A cross sign will appear as illustrated.  
Create your relative scan size diagonally by dragging the 
left mouse button to your preferable size.  The selected 
area will appear in a red box as illustrated.  

A black 
rectangular 
box 

The selected 
image  

The Preview 
Image 

The Preview 
Button 

The Image 
Selection 

Box 



 4-36 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

7. Check the B&W image from the Image Selection box to 
scan the entire document. 

8. Click the Scan button to start scanning the document in 
two image types and sizes.  (See the result in below.)  

   
   The entire document in B&W     The relative area in color 

 

 

 

The 
Relative 
Area  

A Cross 
Sign 
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4.6 The Preview Tab 

 

The Preview tab allows you to preview (a low-resolution scan) 
your image before the actual scan.  This preview image lets you 
manually select your scan area.  You can choose your scan area 
by the ―Scan Area‖ drop down list box or placing your cursor on 
the Display window and dragging it diagonally on the Display 
window.  Then, a red rectangle box will appear to indicate the 
selected area. 
 
Note:  If you choose ―Automatic Cropping‖ on the ―Paper Tab‖, 
then selecting a scan area on the Preview tab is disabled. 
 

 
 

The Preview Tab 

 

 

 

 

 

 

 

The Display 
Window 
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4.7 The Options Tab 

The Options tab allows you to set following additional image 
processing settings.   
 

 

The Option tab dialog box 
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Flip Side 
Rotation 

Select ―fanfold‖ to rotate the image 
of the reverse side to 180 degrees.   

This is applied to double-sided 
document which are viewed in 
portrait are sometime fed into the 
scanner in landscape or vice versa.   

Choice: Book, Fanfold. 

If ―Book‖ is selected, the image of the 
reverse side will not be rotated.  

 
The following illustration shows the documents which should 
be viewed in portrait are fed into the scanner in landscape 
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Rotate Image Choose the rotation angle from the drop 
down list if you wish to rotate your 
scanned image. 

Choice: None, 90°CW(clockwise), 
90°CCW(counter clockwise), 180°, 
Auto based on contents, Auto rotate 
every even page. 

 

Original 

 
Rotate 90°CW 

 
Rotate 90°CCW 

 

Rotate 180° 

 

 Auto based on contents:  When Auto 
based on contents is selected, images 
can be rotated to their proper 
orientations based on their text 
contents. 

Auto rotate every even page: 
Automatically rotate 180° on every 
even page.  This is especially useful 
when you scan the inside pages from a 
book.  As a result, if you choose 
―Flatbed (book)‖ from the ―Scan 
Source‖ option, ―auto rotate every even 
page‖ will be selected as default.   
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Blank Page 
Removal 

Check if you wish to automatically remove 
blank pages and move the slider to the left or 
right to your desired threshold.   

 

Edge Fill 

 

Check White or Black if you wish to add white 
or black edge on the border of your scanned 
image. Enter the value from 0 to 5 mm.  
Default value is 0. 

 
Original 

 
Edge Fill: 5mm (Black) 
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Image 
Control 
Option 

Check the Mirror box if you wish to reverse the right 
and left side of your image. 

 

 
Original 

 

 

 
The Mirror Effect 
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Despeckle 
 

Occasionally small dots or specks appear in the background of a 
scanned image. Remove unwanted speckles provides a cleaner 
image for OCR (Optical Character Recognition) processing, and 
also helps to reduce compressed file size. 
 
Define the speckles (also known as image noise) you wish to 
remove by specifying its number (size) and radius (range). The 
measuring unit is pixel. The higher the number, the more 
speckles will be removed.  
 

 
Before Despeckle  
(noise number:0, noise radius:1) 

 

 

 
After Despeckle  
(noise number:22, noise radius:10) 

 

Note:  

 The function is only for Black and White images. 
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Background 
Setting 

This option allows you to set your scan 
background. 
Choice: White Background, Black 
Background. 
 
 

 
White Background 

 
 

 
Black Background 
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4.8 The Setting Tab  

The Setting tab allows you to set the following settings: 

 

 

The Setting tab dialog box 
 
Energy Saving 

Control 

Check the Enable Energy Saver box 

and move the slider to the right to set 

the amount of time to start the energy 

saver after your last action. The range 

is from 1 to 240 minutes.  The default 

is 15 minutes. 
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Cache 

 

Mode: None, Page Number, Memory 
Size.  
This option allows you to assign a specified 
memory size from the available RAM to 
process the image data. By specifying a 
smaller memory size, you can free more 
memory for other applications you are 
running. By specifying a larger memory 
size, you can have more memory to process 
the image data especially when you have a 
large amount of documents needed to be 
scanned.  
 
You can also specify your memory size by 
the page number. For your information, an 
A4 color document scanning at 300 dpi 
consumes approximates 24MB. 

Image Count 
When the selected cache mode is ―none‖, 
the image count option allows you to assign 
number of pages you need to scan. For 
example, if you wish to scan the first two 
pages, simply move the page slider to 2, 
and the scan action will be stopped when 
the scanning of the first two pages have 
been completed. 
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Show Scanning 

Progress 

Check and the scanning progress bar 

will be shown during scanning. 

Show Warning 

Message 

Check to show the warning messages 

such as ―ADF pad count exceeds 50,000 

scans (the number varies based on type 

of scanner). Please replace the ADF pad 

and reset the pad count.‖ 

Save Settings 

after Closing 

Check to save your scanner properties 

settings after leaving the dialog box.  

Next time when you open the Scanner 

Properties dialog box, the previously 

saved settings will be shown. 
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4.9 The Information Tab  

The Information tab displays the following system and scanner 
information.  

 
 

The Information tab dialog box 
 
 

The “Report” button： 

If you encounter any error message while using the scanner, 
click the Report button.  A report.txt file (C:\M80) will be 
generated.  Please send this file to the technical support agent 
for trouble shooting.   
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5. Using the Buttons  

5.1 The BulletScan Manager 

The buttons on the scanner are controlled by the BulletScan 
Manager.  It is installed by default from the CD when you use 
the Easy Installation mode, and is selected by default when 
choosing the Advanced Installation mode.   
 
The BulletScan Manager provides you with an easy way to scan 
your document and then link the scanned image to your 
designated software application.  All this can be done by a 
simple touch of the button on the scanner.  

 

5.2 Scanning From One Touch of the Button  

1. Place the original document in the scanner, aligning it to 
the left if it is smaller than letter size. 

2. Press the ―One Side‖ or ―Two Sides‖ button on scanner. 
3. The scanner will now pull the paper through, using the 

settings for BulletScan Manager button #1.  In addition to 
using the button on the scanner to scan, you can also use 
the BulletScan Manager button panel to perform scans.   

 
After the scanning is finished, the destination application will be 
launched and the scanned image appears in the application.   

Note: 
For details information on how to use the BulletScan Manager, 
please refer to the BulletScan Manager manual in the supplied 
CD. 
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6. Care and Maintenance 
 

 

 

 

6.1 Cleaning the Scanner Glass 

 

Use the included cleaning cloth to clean the rollers and the 
scanner glass on the following conditions: 
 
 As a guideline, clean the rollers after every 5,000 scans. 

Note that this guideline might vary based on the type of 
documents you are scanning. 

 The scanned images have streaks or scratches. 

 You experience repeated document jams. 

 
To clean the roller and the scanner glass, follow these steps: 
 
1. Open the sealed roller cleaning cloth container, starting at 

the notch. Take care not to tear the cleaning cloth. 

2. Remove the cleaning cloth and unfold it. 

3. Place the unfolded cloth into the paper feed slot. 

4. Press the Scan button to feed the cloth through the 
scanner. 
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Caution: 
Wait two minutes for the components to dry before proceeding 
to the next step. 

 

5. Place one sheet of paper in the scanner. Scan and view the 

results. 

6. If streaks still appear, repeat steps 3 through 5. The 

cleaning cloth can be cycled through the scanner up to five 

times within 30 minutes. After that, the cloth will dry out. 
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7. Troubleshooting 
 
 
 

7.1 Clearing a Paper Jam 

 
In the event of a paper jam, follow the procedures below to 
remove the paper: 
 
To clear a paper jam: 
 

1. Gently pull the paper from the scanner. 

2. Smooth out any wrinkles caused by the jam. 

3. Reinsert the paper to the paper feed slot. 

4. Resume scanning. 

 
 

7.2 Frequently Asked Questions 

 
Question: The scanned image always comes out to be 

too dark. 
Answer: 1) Use your application to modify the Gamma 

setting to 2.2 and 1.8 for your printer and 
monitor respectively. 

 2) Adjust Brightness setting from the TWAIN 
interface to get a brighter image. 

 
Question: The scanner works well except for the line 

art, the lines of which seem much thicker 
than the original. 

Answer: Increase the Brightness or adjust the Threshold 
setting to adjust the line art image.  
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Question: Feeding paper from the ADF easily causes paper 

jam. 
Answer: Make sure to close the front paper tray. While 

the front paper tray is open, feeding paper from 
the automatic document feeder easily causes 
paper jam. 

 

 

7.3 Technical Service  

Before contact iVina, please prepare the following information: 
 

 Scanner serial & revision number (located on the bottom of 
the scanner); 

 Hardware configuration (e.g., your host CPU type, RAM size, 
free disk space, display card, interface card); 

 The name and version of your scanning software application;  
 The version of your scanner driver.  

 
Find us online at: 
 
 

www.bulletscan.com 
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8.  Specifications 
 
 
 
 
All specifications are subject to change without notice. 
 

Model Number M80 

Scanner Type Duplex scanner 

Light source LED 

Technology CIS (Contact Image Sensor) 

Optical Resolution  600 x 600 dpi 

Maximum Scanning Size 8.5‖x14‖ 

Minimum Scanning Size 2.9‖x2.1‖   

Paper Weight 13.3~32 lbs (50 ~ 120 g/m2) 

ID Cards Thickness:  Up to 1.25 mm (0.05 inch) 

Interface High Speed USB 2.0 

Power 5Vdc, 500mA 

Power Consumption < 2.5 watts (operation)  

Operation Temperature
  

10~35°C 

Dimension (WxDxH) 

 

290 x 75 x 52mm  

(11.4 x 3x2 inch)  

Weight  0.674 kg (1.5 lbs) 
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